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IMPORTANT DISCLAIMER 
 
This publication is sold with the understanding that the authors and editors are 

not responsible for the results of any actions taken on the basis of information in 

this work, nor for any errors or omissions; and the publisher is not engaged in 

rendering legal, accounting or other professional services. The publisher, and the 

authors and editors, expressly disclaim all and any liability to any person, 

whether a purchaser of this publication or not, in respect of anything and of the 

consequences of anything done or omitted to be done by any such person in 

reliance, whether whole or partial, upon the whole or any part of the contents of 

this publication.  If legal advice or other expert assistance is required, the 

services of a competent professional person should be sought. 

 

This manual is copyrighted by ELM Computer Systems Inc. 

All Rights Reserved 

 

Under the copyright laws, this manual may not be copied, 

in whole or in part, without the written consent of 

ELM Computer Systems Inc. 

 

Under law, copies cannot be made for others, whether sold or not.  Copying 

includes translating into another language. 

 

Copyright 1992 - 2022 

All Rights Reserved by ELM Computer Systems Inc. 

AvanTax and AvanTax Auto are trademarks 

of ELM Computer Systems Inc. 

 

 

Published by 

ELM Computer Systems Inc. 

One Valleywood Drive 

Markham Ontario  L3R 5L9 

 

Telephone: (416) 495-1624 

Toll Free: 1-800-268-3211 

Fax: (416) 495-0044 

Web site: www.avantax.ca/auto 

E-Mail: support@avantax.ca 
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PROGRAM LICENSE AGREEMENT 
SOFTWARE LICENSE AND LIMITED WARRANTY 

 
Please carefully review this license agreement before installing or using this 

software. BY INSTALLING OR USING THIS SOFTWARE YOU ARE 

AGREEING TO BECOME BOUND BY ALL OF THE TERMS AND 

CONDITIONS STATED IN THIS LICENSE. If you do not agree with any of the 

terms and conditions, promptly return this package and the other items which are 

part of this product to ELM Computer Systems Inc. ("ELM") and your purchase 

price will be refunded. If the complete package has not been returned to ELM 

within 30 days from the date you take possession of the software, then you will 

be deemed to have accepted the terms and conditions of this license. 

 

LICENSE 
The AvanTax Auto Software ("program") is owned by ELM.  ELM hereby grants 

to you a non-exclusive, non-transferable license to use the program. You are 

expressly prohibited from distribution of the program to others outside your 

office, regardless of whether such distribution is for profit. All rights, title and 

interest in and to the program, and all documentation, code and logic which 

describes and/or comprises the program is vested in ELM. Your right to use the 

program is conditional upon and limited by the terms and conditions of this 

license. You may not: (a) modify, adapt, translate, reverse engineer, decompile, 

disassemble, or create derivative works based on the program; or (b) loan, rent, 

lease or sublicense the program or any copy, without the prior written consent of 

ELM. Any violation of these provisions will constitute an automatic revocation 

of your license to use the program and will subject you to substantial liability 

under the applicable legislation of the jurisdiction in which the program is being 

used. 

 

You are permitted to use the program on any and all personal computers in your 

office, with no restriction on the number of concurrent users.  Use of the program 

at other offices (i.e., different street addresses) is prohibited unless separate 

licenses have been purchased for each office. 

 

 

LIMITED WARRANTY AND REMEDIES 
This program and accompanying written materials are provided on an "as is" 

basis without warranty of any kind, either express or implied, including, but not 

limited to, any implied warranties of merchantability or fitness for a particular 

purpose.   This means, among other things, that ELM is not responsible - and you 

are not entitled to a refund - if the program does not meet the requirements for 

which you license it or if the program will not operate free of error. However, 

ELM does warrant that the media on which the program is recorded will be free 

from defects in materials and workmanship under normal use for a period of 90 

days from the date of delivery to you. If you discover a defect in the media 

within the 90 day period, ELM will replace it at no charge upon return of the 

media to ELM at the address stated below along with a copy of your receipt 

showing proof of payment. ELM's entire liability and your exclusive remedy 

shall be the replacement of any media which does not meet ELM's limited 

warranty and which is returned to ELM with a copy of your receipt showing 

proof of payment. If ELM is unable to deliver replacement media which is free of 
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defects in materials or workmanship, you may terminate this license agreement 

by returning the program and related documentation to ELM during the 90 day 

warranty period and you will be entitled to a refund of your purchase price. As 

software is inherently complex and may not be completely free of errors, you are 

advised to verify your work. In no event will ELM be liable to you for any direct 

damages and all other incidental or consequential damages including lost profits, 

data and/or savings, arising out of the use of, or inability to use the program, 

regardless of whether ELM or any authorized dealer has been advised of the 

possibility of such damages occurring. This Agreement represents the entire 

agreement concerning the license and use of the program to which it refers and 

supersedes all previous proposals and/or prior agreements, whether written or 

oral and any other communications by ELM, its authorized dealers, agents and 

employees concerning the subject matter hereof. No dealer, distributor, agent or 

employee is authorized to make any modification or addition to this Agreement 

and this Agreement cannot be modified except by a written document signed by a 

duly authorized officer of ELM. This Agreement will be governed by the laws of 

the Province of Ontario. Any questions regarding this Agreement or the program 

(including the return of defective media) should be addressed to: 

 

ELM Computer Systems Inc. 

One Valleywood Drive 

Markham, Ontario 

L3R 5L9 

 

(416) 495-1624
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CHAPTER 1 

Introduction 

 
  

 

Welcome to AvanTax Auto 
 

AvanTax Auto has been developed by a group of professional accountants with a 

view to support accountants and other professionals in the tedious task of 

computing taxable benefits. 

 

AvanTax Auto will allow you to compute automobile taxable benefits in a 

fraction of the time.  With its "user friendly" approach and its standardized 

questionnaire for orderly capture of required information, AvanTax Auto will 

allow you to proceed with the computation of such benefits in an efficient and 

reliable manner.  The system performs logical operations on the data and 

interacts with the user where certain elections/alternatives are available. 

 

AvanTax Auto has been developed to provide payroll and HR departments with 

an appropriate tool to manage the automobile taxable benefits of all employees. 

 

This is your AvanTax Auto Users Guide.  It is designed for computer users of all 

experience levels.  Use this guide to learn the basic skills and as a reference 

document once you have familiarized yourself with the basics. 

 

 

Technical Support 
 

As a registered user, you will receive notices from us of upgrades to AvanTax 

Auto software, and you may telephone, fax, or email us with your questions 

about the installation and use of the Program.  

 
Toll Free: 1-800-268-3211 

in French: (514) 499-9669 

Fax Number: (416) 495-0044 

in Toronto: (416) 495-1624 

E-Mail: support@avantax.ca 

Web site: www.avantax.ca/auto 

 

ELM Computer Systems Inc. 

One Valleywood Drive 

Markham, Ontario  L3R 5L9 
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CHAPTER 2 

Getting Started 

 
 

 

Hardware Requirements 
 
Operating System 

Windows XP or above. 

 
RAM 

256 Mb RAM. 

 
Disk Space 

At least twenty megabytes of free space on hard drive. 

 
Printer 

A Windows compatible printer. 

 

 

Installing AvanTax Auto 
 

To install AvanTax Auto: 

 

1. Download the installation file, or insert the CD in an appropriate drive. 

 

2. Run “avtsetup.exe”. 

 

3. Follow the instructions on the screen.  You may select any available 

directory for the program; the default directory is C:\Program Files\AvanTax.  If 

you used the 2021 version of AvanTax, we recommend that you install the 2022 

version in the same directory as the 2021 version.  You will still be able to run 

the 2021 program and access the 2021 data exactly as before.  Installing in the 

same directory as the 2021 version will cause the 2021 data to be automatically 

brought forward to 2022.  If you choose to put the 2022 version in a different 

directory than the 2021 version, you can still roll the data forward by using the 

Bring Forward Previous Year’s Data function in the File menu. 

 

 

Network Installation 
 

Install AvanTax Auto on an appropriate network drive, and in the same directory, 

from each workstation that will be using the program. 
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Starting AvanTax Auto 
 
The installation process will add AvanTax Auto to your program list.  Click on 

the AvanTax Auto icon to start the program.  AvanTax Auto will create a 

database in the program directory.  The database will be named AVT2022.MDB 

 

The first time you start AvanTax Auto a Welcome screen is displayed from 

which you are given the opportunity to register the program.  Click on the 

Registration button and in the box provided enter your authorization number 

(from your invoice or, if you ordered the software online, from the email we sent 

you).  If you choose not to register the program at this time, you can click on the 

Start button to begin the program.  However, the unregistered program will allow 

only one company record, one employee record, and one vehicle record to be 

entered.  Once the program has been registered, the welcome screen will no 

longer be displayed upon startup. 

 

 

New Releases 
 
Once you have installed AvanTax Auto on your hard drive, you should install 

new releases for that same application in the same subdirectory.  The information 

you have already entered will be preserved. 

 

 

Choosing French or English 
 

AvanTax Auto is a bilingual program.  When you first start the program you will 

be asked to select French or English as your default language, but you can switch 

to the other language at any time.  To switch from English to French, select 

“Français” from the File menu.  To switch from French to English, select 

“English” from the Fichier menu. When you switch to English, the program will 

close and be in English when you restart it.
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CHAPTER 3 
 

Menus 

 
  

 

Main Menu 
 

When you start AvanTax Auto, it will automatically present the Main Menu on 

the screen.  You will then be able to access the sub menus which will allow you 

to input basic company and employee information, and print reports and 

summaries.  You may enter as many separate companies as you require and there 

is no limit on the number of employees each company can have. 

 

 

 
 
Company/Employee Selection Window 
 

The Company/Employee Selection window on the left side allows you to quickly 

move from one company to another and from one employee to another within a 

company. When you click on a company name the company edit window will 

appear on the right side of the screen; likewise when you click on an employee 

name, the employee edit window will appear. When you move from one 

company or employee to another, the windows will automatically be kept in 

synch with each other. Only one company and one employee may be accessed at 

a time. 
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Sub Menus 
 
File 

The File menu contains the Printer Setup and Exit commands.  There are also 

functions to switch languages, to repair the database, to set per kilometre rates 

and to change the authorization number.  See Chapter 4 for details on these 

commands. 

 
Company 

Each company has a separate record which contains the company information.  

There is no practical limit to the number of companies that can be created, but 

only one company can be accessed at a time.  This company is referred to as the 

current company.  The name of the current company is always displayed in the 

title bar of the AvanTax Auto window. 

 

The commands listed in the Company menu are used to create, delete, and edit 

the company information records as well as to switch between companies. See 

Chapter 5 - Company Management for more details. 

 
Employees 

Each company has a separate list of employees associated with it. The commands 

in the employee menu allow you to create, delete, edit, and switch between these 

employee records.  As with companies, you can access only one employee at a 

time.  The name of this current employee will always be displayed to the right of 

the icon tool bar on the main menu along with the total number of employee 

records entered for the current company.  See Chapter 6 - Employee 

Management for more details. 

 
Vehicles 

A Vehicle Information record should be entered for every vehicle that was 

available to each employee during the year.  The details required to calculate the 

taxable benefit are recorded here.  Use the commands from this menu to create, 

edit, and delete these vehicle information records.  See Chapter 7 - Vehicle 

Management for more details. 

 
Reports 

The commands in the Reports menu are used to generate the various reports 

available from AvanTax Auto.  These include the Company Summary reports 

and the Employee Detailed Computation.  You may also print data entry forms 

and mileage logs, which can be used to collect the necessary data.  See Chapter 8 

- Reports for further information. 

 
Help 

The Help menu allows you access to the help files.  Contents will display a table 

of contents of all the help titles. The Search for Help On command will allow you 

to enter a word or phrase to search for in the help files.  To access help about the 

window you are currently working in, press the F1 key.  If context sensitive help 

exists for that window, it will appear. 

 

The About command displays information regarding your AvanTax Auto 

software, including the version number of the software you are currently using 

and your authorization number.  This window also has a System Info button 
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which reports the hardware and software available on your computer.  You could 

be asked to access this information by the technical support staff were you to 

require technical assistance. 

 

 

Tool Bar Icons 
 

Each screen has a number of icons in the tool bar for quick access.  In 

each case there is a corresponding keyboard short-cut also available.  The 

following is a description of the function of these icons. 

 

New (Ctrl + N) 
Creates a new record of the type indicated at the top of the window.  (Company, 

employee or vehicle). 

 

Save (Ctrl + S) 
Saves the record currently displayed. 

 

Print (Ctrl + P) 
Accesses the Print Reports window. 

  

Company (Alt + C, E) 
Opens the Company information window for the current company.  If there are 

no companies in the database, a new company information record will be opened. 

 

Employees (Alt + E, E) 
Opens the Employee information window for the current employee.  If there are 

no employees for the current company, a new employee information record will 

be opened. 

 

Vehicles (Alt + V, E) 
Opens the Vehicle information window for the current employee.  If there are no 

vehicles for the current employee, a new vehicle information record will be 

opened. 

 

Delete (Ctrl + D) 
Deletes the current record.  You will be asked to confirm that you wish to delete 

the record. 

 

First (Ctrl + F) 
Moves to the first record. 
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Previous (Ctrl + <) 
Moves to the previous record. 

 

Next (Ctrl + >) 
Moves to the next record. 

 

Last (Ctrl + L) 
Moves to the last record.
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CHAPTER 4 

 

File Menu Commands 

 
  

 

Printer Setup 
 

To choose a printer, select Printer Setup from the File menu.  A Print window 

will open listing the printer currently selected.  You may choose a different 

printer by clicking on the current printer name and selecting from the list that 

appears.  If an appropriate printer is not listed, you will need to add the printer to 

the list using the Windows control panel. 

 

 
 

 
You may also select the number of copies to print (the default is one).  When you 

have entered the desired settings click on OK to save the choices. 
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Français/English 
 
When the program is in the English mode, the “Français” option will be available 

from the File menu.  Selecting it will immediately switch all menu options to the 

French language.  When the program in the French mode, the “English” option will 

be available from the  File menu.  Selecting it will cause AvanTax Auto to close.  

When you re-open the program it will be in English mode. 

 

Database Repair 
 
The Database Repair routine in AvanTax Auto may be used to recover from certain 

types of file corruption caused by power failures, software problems, many hardware 

problems, and most common types of operator errors.  However, certain situations 

such as physical damage to the data storage media (hard drive or disks), or 

inadvertent erasure of files cannot be rectified by this routine. 

 

The Repair Database routine should be run if you get an error message about a 

corrupted database.  AvanTax Auto will check the database structure, execute low 

level repair, fix any null values, and compact the database.  Any data that cannot be 

fixed will be discarded.  You will be informed when the repair is complete. 

  

TTIIPP 
It’s a good idea to back up your database before attempting to repair it.  To do 
this exit the AvanTax Auto program, locate the file AVT2022.MDB in your 
program directory, and make a copy of it. 

 

 

Bring Forward Previous Year’s Data 
 
This function locates an AvanTax Auto database from the previous year and copies it 

to the current year database, completely overwriting the current year database. 

 

 

Copy Current Year Data to Planning Year 
 
Use this function to copy the usage data you have entered for the current year to the 

planning year for all vehicles that are still available at the end of the year (i.e. the 

Date Returned box is blank). The total kilometres, personal kilometres and, 

optionally, the reimbursements, will be copied. 

 

 

Change Authorization Number 
 

To change from a single user to a network version of AvanTax Auto (or vice versa), 

you will need to enter a different authorization number.  Select Change Authorization 

Number from the File Menu to delete the authorization number that is currently in 

use.  Then exit the program.  The next time you start AvanTax Auto you will have 

the option to register the program.  Enter the new authorization number at this time. 

 

 

Set per km rates for operating cost benefit 
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Select this function from the File menu to change the rate at which the operating cost 

benefit is calculated.  You can accept or edit the default rate for the standard rate or 

the leasing business rate for both 2022 and 2023. 

 

 

Reset per km rates to default rates 
 

Use this function of the File menu to reset the per kilometre rates to the 

prescribed rates for standard companies and auto dealerships/leasing businesses. 
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CHAPTER 5 

Company Management 

 
 

 

Creating a Company Record 
 

You can enter as many company records as you require.  To create a new 

company record, select the New command from the Company menu or click the 

New icon from within the company window. 

 

 
 

 

 

You may now insert specific information with respect to the employer.   

  
Company File Number 

This field is optional and is used internally for identification purposes only.  The 

number will not appear on any reports.  We recommend that you use the federal 

employer account number as the company file number. 

 
Name 

The company name should be entered in the same manner as you wish it to 

appear on all reports. 

  
Address 

These fields are optional.  The company address is not printed on any of the 

reports.  However, the address may be used to further identify a company. 
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Province 

The province code entered on the company information screen will become the 

default province code for all of the employees added to the company.  This, in 

turn, will determine the tax rates used, and for Québec, whether provincial 

taxable benefits will be calculated and displayed, and whether the QST 

Remittable report will be available.  Either type in the appropriate two character 

province code, or select it from the dropdown list. 

 
Pay Periods Per Year 

This value will be used by the software to produce the "per pay period" estimated 

taxable benefit.  The number entered here will be used as the default value for all 

employees added to the company.  If, however, some employees are paid a 

different number of times per year, the number can be adjusted on the Employee 

Information screen. 

 
Pay Periods to Date 

To aid in the calculation of the taxable benefit per remaining pay period on the 

employee information screen, it is necessary to indicate the number of pay 

periods that have already passed.  The value entered here, on the company 

information screen, will be used as the default value for any new employees 

added to the company. 

 
Car Dealership 

Where the employer operates a car dealership or leasing business, you should 

check the auto dealership check box.  This will ensure that salespersons' or 

leasing agents' taxable benefits are properly computed (see Salesperson on page 

6-2). 

 
Average Cost 

Once you have indicated that an employer operates a car dealership or leasing 

business you will be able to enter the average cost applicable to computations of 

taxable benefits for salespersons/leasing agents (see Car Dealerships and Leasing 

Businesses on page 9-3).  The average cost will be automatically inserted as the 

vehicle cost applicable to salespersons when completing the vehicle description 

for these employees.  Note that the average cost must include GST/HST, but PST 

is not applicable. 

 

AvanTax Auto allows you to insert the average costs with respect to the current 

year and next year (the “planning year”).  At the beginning of the planning year 

you should insert your estimated average cost for the year.  This will allow you to 

calculate per pay period estimates for next year.  The average cost box can only 

be accessed if the company is an auto dealership or leasing business.  Otherwise 

the actual cost of the vehicle is used in all calculations.  The actual cost of the 

vehicle is entered on the Vehicle Information screen. 

  

 

Editing Company Information 
 

After a company record has been created, the company information can be edited 

at any time.  Simply select the Edit command from the Company Menu or right 

click the company name in the Company/Employee tree and click Edit.  The 

company information screen for the current company will appear.  You can 

switch between companies using the arrow icons in the tool bar. 
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Selecting a Company 
 

Although you can enter as many company records as you desire, you are only 

able to access one company at a time.  The name of the current company will 

always be displayed on the title bar of the AvanTax Auto window.  To switch to 

another company you may use the Company/Employee tree, or choose the Select 

command from the Company menu.  This will open a list with the company 

names.  Highlight the desired company name using the mouse or the cursor arrow 

keys.  Then either hit the Enter key or click on the OK button. 

 

 

Deleting a Company 
 

If you select the Delete command in the Company menu a verification message 

will be displayed requesting your confirmation to delete the company record.  

Once that process is activated all of the employees and their associated vehicle 

records for that company will be deleted.  You can also delete a company record 

by clicking on the delete icon on the tool bar at the top of the Company 

Information screen.  Again, you will be asked to confirm the deletion before 

AvanTax Auto will permanently erase the company record.





Company Management 6-1 

 

 

 
CHAPTER 6 

 

Employee Management 

 
  

 

Creating an Employee Record 
 

You must create an employee record for each employee to whom a vehicle 

was made available.  To do this, select the New command from the 

Employee menu or click on the New icon from within the employee 

information screen.  This command will call up the following data input 

screen: 

 

 
 
 
Employee File Number 

This field is optional. It is included to allow for distinction between employees 

other than by name.  Reports may be sorted by file number.  You can enter the 

employees SIN number, an internal employee number, or leave the field blank. 

 
Department 

A department name of up to six characters can be assigned to each employee if 

desired.  This will allow for the printing of company and employee reports by 

department.  Be careful to be consistent with the spelling of the department 
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name, since only exact matches will be included in reports filtered by 

department. 

 

 
Employee Name 

We suggest that you use the "family name, first name" input format (e.g.  

Berridge, Charles) to input the employee names.  This will make searching for an 

employee easier since the employee list will appear in alphabetical order by 

family name. 

 
Province of Employment 

This field is required to accurately calculate the taxes on the cost of vehicle(s) 

entered for the employee.  If Québec is chosen, it will cause the calculation and 

display of provincial taxable benefits.  The default value will be the value entered 

on the company information screen.  It can, however, be edited for each 

employee by simply typing the correct code, or selecting it from the drop down 

list. 

 
Pay periods 

The number of pay periods will be set by default as the number of pay periods 

inserted in the company information screen.  This number will allow the 

computation of the "per pay period" taxable benefit amount. 

 

This field can be overridden, if required, by simply typing in the correct value.  

This may be necessary where some employees are paid more or less frequently 

than others, or where an individual is supplied with a vehicle part way through 

the year.  In the latter circumstance the number of remaining pay periods in the 

year should be inserted. 

 
Salesperson 

Where the employer operates a car dealership or an automobile leasing business, 

you will be prompted to indicate if the employee is a salesperson or leasing agent 

(see Car Dealerships and Leasing Businesses on page 9-3).  If you check this 

box, AvanTax Auto will use the average cost from the company information 

screen as the cost for the vehicle.  In addition, AvanTax Auto will compute the 

standby charge using the reduced rate of 1.5% instead of 2%; and the operating 

costs benefit will be calculated at the prescribed per kilometre rate for 

salespersons or leasing agents instead of the regular rate. 

 
Use Optional Calculation, if Beneficial 

Under certain conditions there is an optional method of calculating the operating 

costs benefit for a vehicle as 50% of the standby charge (see Operating Cost 

section 2b on page 9-3).  If this option is checked, AvanTax Auto will use 

whichever calculation method is most beneficial to the employee.  To use this 

method, the business use of the vehicle must be at least 50% and the employee 

must complete an election form prior to December 31st of the taxation year. 

 
Show Combined Vehicles 

If the employee has more than one vehicle with dates in the current or planning 

year and these vehicles are either all leased or all purchased it may be beneficial 

to merge the vehicles together as if they were one vehicle by using the average 

acquisition cost and the totals of the kilometres driven, days available, and 

amounts reimbursed.  When the Show Combined Vehicles box is checked, the 

program calculates and displays the taxable benefit using the combined data.  
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This allows you to compare the taxable benefit calculated in the two different 

manners.  You will need to indicate whether you want to treat the vehicles as 

individuals or combined when you produce the printed reports. 

 
Important Note: The “combined vehicles” method is not explicitly prescribed by 
Canada.  It has been included in the program at the request of users. 
 

 
Taxable Benefit and Vehicles 

These sections will be blank until vehicle information is entered.   The data will 

be automatically updated with a summary of the data entered in the Vehicle 

Information screen.  See Chapter 7 - Vehicle Management for details on entering 

vehicle information. 

 

The Vehicles list show the name and available dates for each vehicle entered for 

the current employee. If there is more than one vehicle, the most recent vehicle 

will be listed first.  The current vehicle will be highlighted. 

 

As soon as usage and reimbursement values are entered and saved in the vehicle 

information screen the taxable benefit will be displayed.  The Taxable Benefit 

section will show the calculated federal taxable benefit for the highlighted 

vehicle for both the current and planning years.  There will also be a column for 

the Québec taxable benefit if applicable.  If the Show Combined Vehicles box 

has been checked, the taxable benefit for the combined vehicles will be displayed 

beside the value for the current vehicle. 

 

Enter the number of pay periods to date (if different from the default value 

entered on the company information screen) along with the amount included to 

date. AvanTax Auto will then calculate the amount of benefit per remaining pay 

period. 

 

Editing Employee Information 
 

After the employee record has been created, the employee information can be 

edited at any time.  Simply select the Edit command from the Employee Menu.  

The employee information screen for the current employee will appear.  You can 

switch between employees using the arrow icons in the tool bar. 

 

Selecting an Employee 
 

Although you can enter as many employees as you desire, you are only able to 

access one employee at a time.  The name of the current employee will always be 

displayed beside the tool bar at the top of the main window, along with the total 

number of employees entered for the current company.  To switch to another 

employee choose the Select command from the Employee menu.  This will open 

an alphabetic list of the employee names.  (You can also see the list by simply 

clicking on the current employee name.)   Highlight the desired employee name 

using the mouse or the cursor arrow keys.  Then either hit the Enter key or click 

on the OK button. 

  

Deleting an Employee 
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If you select the Delete command in the Employee menu a verification message 

will be displayed requesting your confirmation to delete the employee record.  

Once that process is activated all of the information for the employee, and all of 

the vehicles for that employee, will be deleted.  You can also delete an employee 

record by clicking on the delete icon from the tool bar at the top of the Employee 

Information screen.  Again you will be asked to confirm the deletion before the 

program will permanently erase the record. 
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CHAPTER 7 

 

Vehicle Management 

 
  

 

Creating a Vehicle Record 
 

Each employee should have a separate vehicle information record for each 

vehicle they had access to during the course of the year. To create these records, 

select the New command from the Vehicle menu.  This will create a vehicle 

information record which will be associated with the current employee.  The 

following data input screen will appear: 

  

 
 

  
Description and Serial Number 

This information is used to identify the vehicle.   The description will appear on 

the employee’s information screen and on printed reports.  You may be as 

specific as you require. 

 
Vehicle Cost 

You must identify whether the automobile is owned or leased as this will affect 

whether the acquisition cost or the leasing costs will be used in the calculation of 

the taxable benefit.  In either case you will be prompted to input the correct value 

and the related taxes. 
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TIP 
All costs are to be input excluding GST/HST and PST/QST.  The taxes must be 
input separately, or, you may click on the “Calculate Tax” button to have the 
system calculate the tax at the rate appropriate for the employee’s province of 
employment. Note that for purchased vehicles, the GST rate may be overridden 
to reflect the GST rate at the time the vehicle was purchased. This is to 
accommodate possible mid-year changes to the GST or PST rates. 
 

With respect to leasing costs, you may insert the total leasing cost for the entire 

period the employee had the vehicle, or the monthly leasing cost.  You must label 

the value you have entered by selecting either the ‘monthly payment’ or the 

‘period payment’ option.  The software will thereafter determine the total lease 

cost for the period the vehicle was available. 

 

If the vehicle was not available to the employee for the entire period and the 

monthly lease cost is input, the program will calculate the total lease cost based 

on the number of days the vehicle was available (see below).  However, if the 

lease cost is entered for the entire period, the program assumes you have already 

allowed for the number of days the vehicle was available to the employee. 

 

If you have indicated that the employee is a salesperson or leasing agent, the 

acquisition cost will be inserted automatically as the average cost entered in the 

employer record.  No PST/QST has to be entered in this case, however, the 

amount of GST/HST must be included in the average cost. 

 
Date Automobile Made Available 

Provide, for each vehicle, the date it was made available to the employee.  

Should the vehicle have been acquired prior to January 1 of the current year, you 

can input either January 1 or the actual date that the vehicle was received by the 

employee. 

 
Date Automobile Returned 

The input of the "Date returned" is important since the software will 

automatically determine the number of days an automobile was available to an 

employee.  If this field is left blank, AvanTax Auto will assume that the vehicle 

has not yet been returned and was therefore still available to the employee on 

December 31st. 

 
Number of Days Available 

When you enter the dates available and returned, AvanTax Auto will 

automatically calculate the maximum number of days that the vehicle was 

accessible to the employee during the current year, or would be accessible during 

the planning year. If the vehicle was not available each day during the period, 

enter the actual number of days available. 

 
Total/Personal Kilometres Driven 

Enter the total number of kilometres driven in this vehicle by this employee. On 

the next line enter the number of personal kilometres driven by the employee. 

 
Reimbursements 

a) Standby Charge 

Enter the total of all reimbursements made by the employee during the calendar 

year with respect to the use of the vehicle, other than reimbursements with 

respect to the operating costs. 
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b) Operating Costs 

Enter the total of all reimbursements with respect to the operating costs made by 

the employee prior to February 15 of the year following the year for which the 

taxable benefit is computed. 

 

Where reimbursements are made with respect to operating costs, you will also be 

prompted to input the total actual operating costs (including PST and GST/HST) 

incurred by the employer while the vehicle was available to the particular 

employee. 

 

The software will thereafter compute the amount of operating costs attributable 

to personal use and compare that amount to the reimbursements made to 

determine if an operating costs benefit applies (see Reimbursements page 9-3).  

 

After all relevant information has been input click the Save icon or press Ctrl + S 

to save the data.  Once the permanent information has been saved, the Vehicles 

List and taxable benefit information will be updated on the appropriate employee 

information screen. 

 

 
TIP 
When multiple automobiles  
are made available to an employee, they will be listed in the order of most recent 
acquisition first. 

 

 

Editing Vehicle Information 
 

After a vehicle record has been created, the vehicle information can be edited at 

any time.  Simply select the Edit command from the Vehicle Menu.  The vehicle 

information screen for the current vehicle will appear.  You can switch between 

vehicles using the arrow icons in the tool bar. 

 

 

Deleting a Vehicle 
 

If you select the Delete command in the Vehicle menu a verification message 

will be displayed requesting your confirmation to delete the vehicle record.  Once 

that process is activated all of the information for the vehicle will be deleted.  

You can also delete a vehicle record by clicking on the delete icon from the tool 

bar at the top of the Vehicle Information screen.  Again you will be asked to 

confirm the deletion before AvanTax Auto will permanently erase the record. 
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CHAPTER 8 

Reports 

 
  

 

Company Summaries 
 

After selecting Company Summaries from the Reports menu the Company 

Summary Reports window will open. 

  

 
 

 
Selected Company 

The name of the current company will appear in the Selected Company section.  

If the company currently listed is not the desired company, simply switch to it 

using the Select command from the Company menu. 

 
Provinces 

Generally, you would leave this setting set to ‘All Provinces’.  However, in some 

cases, where you have companies with employee in more than one province, you 

may wish to produce reports for one specific province.  In that case, click on 

‘Select’ and then choose the desired province from the list in the box to the right. 

  
Taxation Year 

Indicate the year for which you want to produce reports.  You may select either 

the current year or the planning year. 
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Departments 

You may produce reports that include ‘All Departments’, or you may type in the 

name of the one department you require the report for.  Make sure that the 

department name is entered exactly as it appears on the employee information 

screen. 

 
Sort Employees By 

You can choose the order in which the employees will be listed on the reports 

from the options listed.  Whenever ‘Name’ is selected, the employees will be 

listed alphabetically by the full name as entered.  To produce a listing that is 

alphabetical by family name the names must be entered in the Family Name, 

First Name format. 

 
Reports to Print 

AvanTax Auto provides you with the following company summary reports: 

 

• Taxable Benefits Summary 

• Employee/Vehicle List 

• Taxable Benefits per Pay Period 

• Remittable GST, and 

• Remittable QST 

 

Examples of these reports are provided in Appendix "E".  You may select any 

one or more of these reports to print by checking the appropriate box(es).  Then 

click on “Print” to proceed with the printing or “Preview” to view the report on 

screen. 

 

 

Employee Detailed Computation 
 

The Employee Detailed Computation Reports window is very similar to the 

Company Summary Reports window.  The following paragraphs describe the 

options unique to the employee detail report window. 

 

Most of the options are the same as those for the Company Summary Reports. 

 
Employees 

The employee selection will allow for the printing of just the current employee or 

all of the employees for the company.  If the employee currently listed is not the 

desired employee, simply switch to it using the Select command from the 

Employee menu. 

 
Print Election Forms 

Where the reduced benefit election applies and is determined to be beneficial to 

an employee, and you have indicated on the employee record that the employee 

will make this election, the applicable election form will be printed automatically 

following the employee's detailed computation if this box is checked. 

  
Québec Employees 

If there are employees with Québec for their province of employment in the 

current company, you will be given the option of printing the federal taxable 

benefit report alone, the Québec taxable benefit report alone, or both reports at 

the same time.  Note: For the 2022 taxation year, the federal and Québec 

calculations are identical.  This option is available for future use. 
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Data Entry Form 
 

This form has been designed to standardize and ease the process of information 

gathering with respect to automobile taxable benefits.  It is designed so that all 

required information to perform the benefit computation is listed.  This 

form/questionnaire can be printed with some basic information, such as the 

employee name and vehicle description, or a blank form can be printed. 

  

 Mileage Log 
 

The mileage log can be printed and distributed to employees to track their 

personal mileage.  It can be printed with the employee name and vehicle 

description, or a blank form can be printed. 
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CHAPTER 9 

 

About the Legislation 

 
 

 

Definitions 
 

The Canadian Income Tax Act (ITA), Excise Tax Act (GST), Québec Taxation 

Act (QTA) and Québec Sales Tax Act (QST) have their own definitions for 

certain common terms.  The following definitions found in this legislation will be 

relevant in determining the requirements to compute the taxable benefit and/or 

remit applicable GST/HST. 

 
Automobile 

That term will generally include motor vehicles that are designed or adapted to 

carry individuals on highways and streets, and have a seating capacity for not 

more than the driver and eight passengers. 

 

The following vehicles are excluded from the definition of automobile: 

• ambulance; 

• taxi; 

• bus; or 

• funeral hearse 

 

Van and pick up trucks are also excluded in the following circumstances: 

 

a) The seating capacity is limited to the driver and two passengers and it is used 

primarily (generally understood to be more than 50%) for the transportation of 

goods or equipment in the course of business, or 

 

b) The seating capacity is not limited but its use is "all or substantially all (90% 

or more) for the transportation of goods, equipment or passengers in the course of 

the business". 

 
Personal Driving 

Personal driving is any driving by an employee, or a person related to the 

employee, for purposes other than in the course of his or her employment.  This 

includes: 

• vacation trips; 

• driving for personal use; and 

• travel between home and work (even if the employer insists that the employee 

drive the vehicle home). 

 
Number of Months 

The number of months, for the purposes of all taxable benefits calculations, is to 

be calculated as the total number of days available divided by 30 and rounded off 

to the nearest whole number if it is more than one. 
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Computation of Taxable Benefits 
 
Federal 

 

The automobile taxable benefit for purposes of the ITA is the sum of the standby 

charge benefit and the operating costs benefit minus any reimbursements the 

employee makes in the year.  This section provides a summary of the rules 

affecting the computation for both employer-owned and leased automobiles: 

 
Basic Taxable Benefit 

 

1.  Standby Charge 

 

 a) Employer Owned Car 

 

  i) if business use is less than or equal to 50% 

 

2% 

x 

number of months 

x 

cost of the vehicle 

(including PST and GST/HST) 

 

ii) if business use is greater than 50% and the number of personal-use 

kilometres in the taxation year is less than 20,000 kilometres (1,667 

kilometres per month) 

 

2% 

x 

   personal km               

no. of months x 1,667 km 

x 

no. of months 

x 

cost of the vehicle 

(including PST and GST/HST) 

 

 b) Employer Leased Car 

 

  i) if business use is less than or equal to 50% 

 

2/3 of lease costs 

(including GST/HST and PST, excluding insurance) 

 

  

  ii) if business use is greater than 50% 

 

   personal km    

number of months x 1,667 km 

x 

2/3 of lease costs 

(including GST/HST and PST, excluding insurance) 
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2. Operating Costs Benefits 

 

 a) if business use is less than or equal to 50% 

 

prescribed cents per km multiplied by the number of personal kilometres 

 

 b) if business use is greater than 50%, and employee has produced 

applicable election form prior to December 31st: 

 

The lesser of the amount computed in a) 

and 50% of the standby charge 

(computed prior to any reimbursements made by the employee). 

 

3. Reimbursements 

 

 a) Standby Charge 

 

The standby charge benefit determined above is then reduced by all related 

reimbursements made during the calendar year by the employee to the 

employer.  Excess reimbursements with respect to standby charge benefit do 

not reduce the operating costs benefit, and vice versa. 

 

 b) Operating Costs Benefit 

 

The operating costs benefit determined above is then reduced by all related 

reimbursements made by the employee to the employer prior to February 15 

of the following year. 

 

However, where reimbursements made within the period noted above are 

equal to or exceed the actual operating costs (including PST and GST/HST) 

incurred by the employer, attributable to the personal use of the vehicle by 

the employee, no taxable benefit applies with respect to such operating costs. 

 
Québec 

For purposes of computing the automobile taxable benefit to be reported on 

Québec Relevé 1's, the employers are required to first compute the standby 

charge and operating cost benefits, and then compute the QST taxable benefit. 

 

The Québec standby charge taxable benefit and operating cost benefits are 

computed using the same formulae as the Federal calculation. 

 

  

Car Dealerships and Leasing Businesses 
 

These employers have the option (no election is to be filed with Revenue Canada, 

Taxation or the Minister of Revenue of Québec) to compute the automobile 

taxable benefit standby charge using a reduced factor of 1.5% instead of 2% 

where the employee is employed principally (i.e. more than 50%) in selling or 

leasing automobiles. 
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If the employer uses the option for purposes of the computation, the cost of the 

automobile will be determined as the greater of: 

 

a)  the average cost of new automobiles acquired in the year for sale or lease. 

 

b)  the average cost of all (new and used) automobiles acquired in the year for 

sale or lease. 

 

These two items are computed including GST/HST and excluding PST/QST.  In 

addition, the prescribed rate for salespersons or leasing agents rather than the 

regular rate is used to calculate the operating costs benefit for kilometres driven 

for personal use. 

 

 

GST/HST Computation, Reporting and Remittance 
 
Computation 

The amount of the net remittable GST with respect to a particular employee will 

include a fraction of the standby charge before deducting reimbursements, and a 

percentage of the operating costs benefit, also before deducting reimbursements.   

 

The prescribed rates depend on the province of employment which you enter for 

the employee. The rates are as follows for 2022 and 2023: 

 
  2022 

standby  
charge  
 

2022 
operating  
cost benefit  

2023 
standby  
charge  

2023 
operating  
cost benefit  

GST provinces  4/104  3%  4/104  3%  

NB 14/114  11% 14/114  11% 

NF 14/114 11% 14/114 11% 

NS  14/114  11%  14/114  11%  

QC – GST  4/104  3%  4/104  3%  

QC – QST  9.975 / 
109.975  
 

6%  9.975 / 
109.975 

6%  

ON – usual rate 12/112 9% 12/112 9% 

ON – large businesses required to 
recapture ITCs 
 

12/112 8.4% 12/112 8.4% 

PE – usual rate 14/114  11%  14/114  11%  

PE – large businesses required to 
recapture ITCs 
 

6.5/106.5 7.8% 6.5/106.5 7.8% 

 

Liability 
In all situations the employer has to remit the amount of the GST/HST included 

in the taxable benefit except in the following circumstances under which an 

employer will not have claimed an input tax credit (ITC) on acquisition or lease 

of the automobile: 

 

a)  the employer acquired the automobile in 1991 and was not allowed to claim 

an input tax credit as a result of section 170 of the GST/HST; 
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b)  an election not to claim an ITC was made by the employer pursuant to 

amended section 173(2) of the GST.  This election is available to employers 

other than financial institutions who lease an automobile and the automobile is 

not used primarily in commercial activities, or employers who are financial 

institutions who acquire or lease an automobile; 

 

c)  the employer is an individual or partnership and the automobile is not used 

90% or more in commercial activities, and; 

  

d)  the employer is not an individual, partnership or financial institution and the 

automobile is not used primarily (more than 50%) in commercial activities. 

 
Timing of Reporting 

1.  Employees other than shareholders 

 

The GST/HST with respect to taxable benefits will be deemed to have arisen on 

the last day of February following the calendar year and the GST/HST will be 

reported on the GST/HST return covering the period which includes that day. 

 

2.  Shareholders 

 

The GST/HST with respect to taxable benefits will be deemed to have arisen on 

the last day of the employer's taxation year in which the automobile was made 

available to the shareholder and the GST/HST will be reported on the GST/HST 

return covering the period which includes that day. 

 

QST Reporting 
 

The amount of net remittable QST with respect to an employee will include, for 

the 2022 taxation year, 9.975/109.975 of the standby charge before deducting 

reimbursements, and 6.0% of the operating costs benefit, also before deducting 

reimbursements.  
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Data Entry Form 
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Automobile Taxable Benefit Input Form 

Taxation Year 2022 

 
Employer:                                           

 

Employee:                                              

File No.:                                       

Province:                                      

Department:                             

 
Vehicle Information 

  

Description: ______________________________________ 

Serial no.: ______________________________________ 

 

Cost:  _____________ 

GST/HST: _____________ 

PST:  _____________ 

  

Usage Information 

  

Date vehicle made available:  _______________ 

Date vehicle returned:   _______________ 

Days available, if not entire period: _______________ 

 

Total kilometres driven:   _______________ 

Personal kilometres driven:  _______________ 

Reimbursements 

  

Re. standby charge:   _______________ 

Re. operating costs:   _______________ 

*Actual operating costs:   _______________ 
(including GST/HST and PST) 

 

 
• Only applicable where employee made reimbursements with respect to personal use of the vehicle 

 

 
 

 

 
 

Employee’s signature 
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APPENDIX B 

 

Reduced Benefit Election Form 
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Québec Automobile Taxable Benefit 

Request to Use Optional Calculation 

Taxation Year 2022 

 
 

 

 

Employer: Gismo Manufacturing 

 

  

 

 

I hereby elect to have my automobile benefit calculated pursuant 

to Section 41.1 of the Québec Taxation Act. 

 

  

  

 

 

 

 

    ___________________________________ 
Murray, George 

 

 

______________________________________ 

Date 
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Federal Automobile Taxable Benefit 

Request to Use Optional Calculation 

Taxation Year 2022 

 
 

 

 

Employer: Gismo Manufacturing 

 

 

 

 

I hereby elect to have my automobile benefit calculated pursuant 

to Section 6(1)(k) of the Canadian Income Tax Act. 

 

 

 

 

 

 

 

 

 

 

 

   __________________________________________ 

Murray, George 

 

 

   ___________________________________________ 

Date 
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APPENDIX C 

 

Sample Reports 
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Automobile Taxable Benefits Summary                             Taxation Year 2022 

 
Company: Auto Perform Inc. 

 

 
Employee Name File No. Prov Dept Taxable Benefit 

 

Ashton, April  A123  ON SALES    562 

Barker, Brian  B053  ON SALES    148 

Carpenter, Carrie C384  ON ADMIN    853 

Dolby, Daryl  D913  ON SALES    138 

 

   COMPANY TOTALS:   1,701 

 

 

 

 

 

 

 

 

 
Automobile Taxable Benefits Per Pay Period                Taxation Year 2022 

 
Company: Auto Perform Inc.  

 

 

Employee Name Pay Pds Pay Pds Federal Taxable Benefit 

 Prov. Dept. File No. Per Yr To Date Total To Date Per pay 

 
Ashton, April 

 ON SALES A123 24  21 562 0 187 

Barker, Brian 

 ON SALES B053 24  21 148 0 49 

Carpenter, Carrie 

 ON ADMIN C384 24  21 853 0 284 

Dobly, Daryl 

 ON SALES D913 24 21      138        0       46 
  

COMPANY TOTALS:      1,701         0      567 
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Net Remittable GST/HST Re. Automobile Taxable Benefits         Taxation Year 2022 

 
Company: Auto Perform Inc.                                       * before reimbursements 

 

Employee Name  *Standby *Oper. Tax Included In Total 

  Prov. Dept. File No.  Charge  Cost    S.C.    O.C. Tax Incl 

 
Ashton, April   1,260  502  71  25  96  

  NF SALES A123 

Barker, Brian  535 213 30 11 41 

  NF SALES B053 

Carpenter, Carrie  667 266 38 13 51 

  NF ADMIN C384 

Dobly, Daryl     528  210    30    10    40 

  NF SALES D913 

 
COMPANY TOTALS: 2,990  1,191  169    59  228  

 

 

 

 

 

 

 
Net Remittable QST Re. Automobile Taxable Benefits          Taxation Year 2022 

 
Company: Auto Perform Inc.                                               * before reimbursements 

 
Employee Name *Standby *Oper. Tax Included In Total 

  Prov. Dept. File No.. Charge Cost    S.C.    O.C. Tax Incl 

 

Ashton, Alan 

  QC SALES A123 1,575 354 110 20 130 

Barker, Brian 

  QC SALES B053 669 150 47 9 56 

Carpenter, Carrie 

  QC ADMIN C384 869 195 61 11 72 

Dobly, Daryl 

  QC SALES D913   659   148    46     8    54 
 
 COMPANY TOTALS:  3,772   847   264    48    312 
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Federal Automobile Taxable Benefit Calculation              Taxation Year 2022 

 
 
Employer: Auto Perform Inc. File No.: A123 

Employee: Ashton, April Province: ON 

Vehicle: Audi Department: Service 

Ser. No.:  

 
Acquisition cost 30,957 

GST/HST on acquisition 4,024 

Number of days vehicle available 365 

Number of months vehicle available 12.00 

Total kilometres driven 36,250 

Personal kilometres driven 2,950 

Employee reimbursements re. standby charge 800 

Employee reimbursements re. operating costs 400 

Actual operating costs 0 

 
 

Standby Charge 

 

                 2%  x   34,981   x   12   x         2,950   = 1,238 

 20,004 

 Less: Amount reimbursed by employee:   (800) 

 438 

 

Operating Costs 

 

 2,950   x       0.28    = 826 

 

 Less: amount reimbursed by employee:   (400) 

         426  

 

TOTAL FEDERAL TAXABLE BENEFITS              864 
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APPENDIX D 
 

Import Data 

 
 
 
Note:  Import and Export features are available only in the Plus 
version of AvanTax Auto. 

 
 

If you have information in a spreadsheet, a payroll program or another 

software package, you may be able to import it into AvanTax Auto. Some 

examples of this would be a spreadsheet from your leasing company with 

new lease rates, an export from your payroll package with employee 

names and departments, or a spreadsheet with total and personal 

kilometres for each vehicle. 

 

You can import both employee information and vehicle information, and 

you can both add new employees and vehicles, and update existing 

employees and vehicles. 

 

 

Creating Import Files 
 

The files that AvanTax Auto imports are .csv (comma separated values) 

files. These files can be opened, edited and saved by spreadsheet programs 

like Microsoft Excel.  

 

The file is structured with keywords as column headings, followed by a 

row for each employee or vehicle to be imported. Fields within a row are 

separated by commas. Fields containing commas are delimited with 

double quote marks. 

 

To help you get started, we recommend that you use AvanTax Auto to 

export the Employee List and the Vehicle List. This will create .csv files 

which you can use as templates containing all the columns that can be 

imported by AvanTax Auto.  

 

Once you have a template to work with, you can remove the columns you 

don’t need and replace the exported values with new data (e.g. new lease 

rates or kilometres). 
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Step-by-step Procedure 
 

Here is an example of how to create and import a file to update existing 

vehicle data. For this example, the goal is to update the existing list of 

vehicles with the personal and total kilometres driven for the year. 

 

1. Export the Vehicle report. 

a. Select File/Export Data, select the Vehicle List checkbox, 

set options for filtering or sorting and click Export. (Note: 

to export a Vehicle List, you must have at least one 

employee with a vehicle for the Current or Planning year.)  

 

2. In Excel, open the Vehicle list you exported from AvanTax Auto. 

You will see something like this: 

 

 

 
 

 

3. Delete the first two rows (report title and company name). 

 

4. Delete columns or enter “NULL” in the heading of columns you 

do not wish to import. 

 

5. For Vehicle imports, ensure that your file contains at least one of 

the Vehicle “key” fields (Description or SerialNumber), as well as 

one of the Employee key fields (Name or FileNumber). For 

Employee imports, only an Employee key field (Name or 

FileNumber) is required. For our example, we will use the 

Employee name and the Vehicle serial number. 

 

6. Enter or copy and paste into the spreadsheet the data you want to 

import. In this example, the total and personal kilometres for the 

current year are being imported. 
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7. Save the spreadsheet as a .csv file. 

 

8. Start AvanTax Auto and select Import Data from the File menu.  

 

 

 
 

 

9. Click Select to locate the .csv file to import. 

 

10. Select either “Employees” or “Vehicles” as the type of data to be 

imported. For our example, select “Vehicles”.  

 

11. Select the matching field to use for updating employees or vehicles 

that are already in the database. For employees you can select 

either “Employee name” or “Employee file number”. For vehicles, 

choose either “Serial# / Unit#” or “Vehicle description”. The 

matching field that you choose must be one of the columns in your 

import file, of course.  
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For our example, select “Vehicle serial/unit #” as the matching 

field. 

 

12. Select either “Skip” or “Add” as the action to take when a 

matching record is not found. Since we are updating existing 

vehicles, we don’t expect to add any new vehicles, so select 

“Skip”. 

 

13. Click Start to import the data. If inconsistencies are found, the 

Import will either be terminated or you will be warned, depending 

on the type of inconsistency found. 

 

14. If new employee records have been added during the import, you 

will be prompted to restart AvanTax Auto to finalize the changes. 

 

 

Headings for Import File 
 
Keywords are used as column headings by the import function to identify 

the information in the column. Generally, each keyword is the name of a 

field in either the Employee or Vehicle table in the database. A special 

keyword, NULL, can be used to cause the import to ignore a column. 

 

Text fields are alphanumeric fields with a specified maximum size. If the 

data to be imported exceeds the maximum size, the import will halt with 

an error. 

 

Yes/No fields. Acceptable values for “Yes” are: Y, YES, OUI or TRUE. 

Any other value (except blank) will be treated as “No”. 

 

Numeric fields are for dollar amounts, kilometres and other quantities, 

such as number of pay periods. They must be rounded and formatted as 

even dollars. For example, $1,200.75 should be formatted as 1201.  

 

Some fields have default values that will be used if the field is not present 

in the import file. These are listed in the Defaults columns in the tables 

below. 

 

Values that are omitted will be skipped over. This means that the import 

will not blank out text fields. It will, however, import zeroes into numeric 

fields if a zero (not a blank) is in the .csv file. 
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Headings for Employee Information 
 

Heading Description Type, max. size Defaults 

NAME Employee name Text, 30  

FILENUMBER Employee file 

number 

Text, 15  

PROV Province of 

employment 

Text, 2 Company default 

SALESPERSON Salesperson or 

leasing agent? 

Yes/No Company default 

DEPARTMENT Department Text, 6  

LANGUAGE Language for 

employee 

correspondence 

Text, 1 (E or A 

for English, F 

for French) 

Company default 

PAYPERIODS # pay periods per 

year 

Numeric Company default 

USEOPTIONALCALC Use optional 

calculation if 

beneficial? 

Yes/No Yes 
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Headings for Vehicle Information 
 

Heading Description Type, max. size Defaults 

DESCRIPTION Vehicle 

description 

Text, 40  

SERIALNUMBER Serial # or Unit # Text, 20  

LEASED Leased vehicle? Yes/No No 

COSTTYPE Code for type of 

cost 

M=Monthly lease, 

P=Period lease, 

C=Acquisition 

cost 

Text, 1 C 

COST Lease or 

acquisition cost, 

before taxes 

Numeric  

GST GST on cost Numeric  

PST PST on cost Numeric  

DATEAVAILABLE Date vehicle made 

available 

Date Beginning of 

year 

DATERETURNED Date vehicle 

returned 

Date End of year 

DAYSAVAILABLECUR 

* 

Days available    

TOTALKMCUR * Total kilometres   

PERSONALKMCUR * Personal 

kilometres 

  

SBCREIMBCUR * Reimbursement re. 

standby charge 

  

OPCOSTREIMBCUR * Reimbursement re. 

operating cost 

  

ACTUALCOSTCUR * Actual operating 

cost 

  

 

* For these fields, to import the planning year instead of the current year 

information, replace “CUR” with “PLAN”. 

 


